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1. HazView Overview 

1.1 System Overview 
A simplified block diagram of a typical HazView installation is shown in Figure 1.1-1. HazView 
runs on any handheld device running Microsoft Pocket PC 2002 with an RS-232 interface. 
HazView interfaces to a Climatronics TACMET II Portable Weather Station specially 
configured for HazMat and Homeland Security real-time weather data requirements. HazView 
periodically receives either NOAA CAMEO/ALOHA formatted weather data or raw 
meteorological data from the weather station sensor over the RS-232 serial link. After 
processing, HazView displays either the CAMEO/ALOHA data (in Base mode) or the raw 
weather station data (in Remote mode). 

HazView
Handheld

Device

Portable
Weather
Station

Weather Sensor
Data

RS-232

CAMEO/ALOHA
Data

 
Figure 1.1-1  HazView Block Diagram 

1.2 Application Overview 
The main application window for HazView (in Remote mode) is shown in Figure 1.2-1.  

 
Figure 1.2-1 Main Application Window 
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The HazView application follows standard Windows CE conventions for layout and control. 
Application functions are accessed primarily through the menu bar. Tapping on a menu item 
either performs a function or reveals a submenu, from which an item may be selected.  Note that 
since HazView makes exclusive use of the RS-232 communications port, any other application 
(e.g. ActiveSync) which would normally use the port must be shut-down or disabled prior to 
activating HazView. An error message like that shown in Figure 1.2-2 may indicate that another 
application is currently using the communications port and must be disabled.  Exit HazView via 
File > Exit (do not ‘X’ out), disable all other communication port applications, and restart 
HazView. 

 
Figure 1.2-2 Communication Initialization Error Message 

1.3 Application Data Processing 
Processing in the HazView application is driven by two periodic, but independent, data update 
rates- the sensor update data rate and the averaging data rate. The processing and activities that 
occur during these two intervals are described below. 

1.3.1 Sensor Update Interval 
The sensor update rate is fixed at one input per second when HazView is running in remote 
mode, and one input every thirty seconds when running in Base mode. When data is received on 
the serial interface, the data is stored internally and if either the Base or Remote view is currently 
active, all values are refreshed with the new current values. Additionally, if the Current Input 
Data screen is being viewed (see Section 1.5.2.3) or if the Data Stream dialog is displayed (see 
Section 1.5.3.2) in Remote mode, the current input data stream (and the individual sensor 
components in the case of the Data Stream dialog) is refreshed to the latest values received. 

1.3.2 Data Averaging Interval 
The data averaging interval is fixed at one minute. At the data averaging interval, the maximum 
wind speed reading obtained during the last average interval and the wind direction extents are 
determined. The data averaging operations only start after at least a full interval has passed since 
the start of the HazView application. Additionally, the data averaging operations take place on 
even minute boundaries of the system clock. For example, if the application is started at 8:01:32, 
the data averaging will take place at 8:03:00, 8:03:00, 8:05:00 and so on. 
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1.4 Application Views 
Two basic views are available in the application client area – the Base (ALOHA/CAMEO) view 
or the Remote view. Selecting either view is performed using the view menu or using the 
associated toolbar button.  

1.4.1 Base View 
The Base view is selected using the View menu or by clicking on the Base view icon on the 
toolbar. A sample Base view is shown in Figure 1.4-1. 

 
Figure 1.4-1 Base View 

1.4.1.1 Base View Elements 
In the Base view the exact CAMEO/ALOHA data received from the sensor is displayed. No 
additional processing is performed on the data. Display areas are provided for the instantaneous 
wind speed, direction and temperature, the five minute average wind speed, direction and 
temperature, the standard deviation (sigma theta) of the wind direction and the battery voltage. 
Note that he units of measure associated with each of these display areas are fixed and cannot be 
varied using the Units menu. 
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1.4.2 Remote View 
The Remote view is selected using the View menu or by clicking on the Remote view icon on 
the toolbar. A sample Remote view is shown in Figure 1.4-2. 

 
Figure 1.4-2 Remote View 

1.4.2.1 Remote View Elements 
In the Remote view, digital display areas are provided for the instantaneous wind speed, 
maximum wind speed, wind direction, air temperature, relative humidity, pressure, precipitation, 
battery voltage and radiation depending on the sensors selected. The units of measure associated 
with each of these digital display areas can be varied using the Units menu. Note that the 
maximum speed display is unique in that there cannot be an instantaneous maximum wind speed. 
The maximum speed can only be calculated over the interval of interest. On the instantaneous 
display therefore, the maximum speed indicator shows the maximum speed over the last average 
interval, not any instantaneous value. As such, the maximum speed indicator on the 
instantaneous display will show asterisks until the first average interval has passed and a 
maximum value can be computed. 
The Remote view also includes an easy to read analog display of the wind direction. The blue 
band on the analog dial indicates the variability of the wind direction over the last interval of 
interest. Like the maximum wind speed, the blue band will appear on the Remote view display 
only after the average interval has passed and the wind variability can be calculated. 
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1.5 Application Menus 
Much of the operation of the HazView application is accomplished through the application 
menu. Selecting a menu item causes a submenu to be presented. Selecting a submenu item in 
turn causes an action to be performed, an interface element such as a dialog box to be displayed, 
or another submenu to be displayed. The following sections describe the functions performed by 
each menu and submenu item. 

1.5.1 File 

 
Figure 1.5-1 File Menu 

1.5.1.1 Exit 
Toolbar: No 
Exits the application. It is highly recommended that this exit selection is used to close the 
application as this will relinquish the serial port for use by other applications (such as 
ActiveSync). Failure to disable other applications which use the serial port prior to activating 
HazView will cause a communication initialization error (see Section 1.2). 

1.5.2 View 

 
Figure 1.5-2 View Menu 

1.5.2.1 Base Data 
Toolbar:  
The current data view is modified to display the ALOHA/CAMEO data (Base mode). 

1.5.2.2 Remote Data 
Toolbar:  
The current data view is modified to display raw meteorological data (Remote mode). 
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1.5.2.3 Current Input Data … 
Toolbar: No  
The Current Input Data selection allows the user to view in real time the raw, unprocessed, 
meteorological sensor data (in Remote mode) or ALOHA/CAMEO data (in Base Mode) received 
over the serial link. A sample Last Received Input Data screen in shown in Figure 1.5-3. 

 
Figure 1.5-3 Last Received Input Data Display 

1.5.3 Setup 

 
Figure 1.5-4 Setup Menu (Remote Mode) 
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1.5.3.1 System Configuration … 
Toolbar: No 
Presents the HazView System Configuration dialog box (sample shown in Figure 1.5-5) that 
allows the user to select the sensors present in the particular system configuration, and the input 
units associated with each of those sensors.  Note that this dialog is not available in Base mode. 

 
Figure 1.5-5 System Configuration Dialog (Remote Mode) 

The check boxes next to each sensor enable the user to specify if a particular sensor is present in 
the application or not. For certain sensor types, the user must specify the units associated with 
the input data.  Note that this unit specification is independent of the output units displayed on 
the Remote mode display.  The units specified on the System Configuration Menu must match 
the units associated with the input data, while the units chosen for the output display are entirely 
up to the user. 

   7



HazView User’s Guide Date: February 13, 2004 
 
 
1.5.3.2 Data Stream … 
Toolbar: No 
Presents the HazView System Data Stream dialog box (sample shown in Figure 1.5-6) that 
allows the user to match the HazView application to the incoming sensor data stream. Note that 
this menu is not available in Base mode. 

 
Figure 1.5-6 System Data Stream Dialog (Remote Mode) 

The format of the input sensor data stream is dependent on the particular user’s application. The 
user uses the Data Stream dialog to match each meteorological sensor to the correct field in the 
input data stream. For each sensor present, the user then uses the Start and End edit fields to 
select the starting and ending characters in the data stream which correspond to the sensor data. 
The Sensor Data boxes update in real time to indicate the actual characters that will be used to 
specify the sensor data. The “Two Line Input” checkbox is used to indicate that the serial input 
stream is formatted in two lines. That is, the input stream for one complete message consists of 
80 characters of data, a carriage return-line feed pair, additional data characters, and a final 
carriage return-line feed pair. 
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1.5.3.3 Serial Interface Settings … 
Toolbar: No 
Presents the Sensor Serial Interface Settings dialog box (shown in Figure 1.5-7) that allows the 
user to specify the serial interface parameters. Note that this dialog is not available in Base mode. 

 
Figure 1.5-7 Sensor Serial Interface Settings Dialog (Remote Mode) 

The Baud rate pulldown and Parity, Data Bits and Stop Bits radio boxes are used to match the 
HazView serial port settings to the incoming sensor data stream parameters.  
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1.5.3.4 Background Color … 
Toolbar: No 
Presents Color Selection dialog box (shown in Figure 1.5-8) that allows the user to specify the 
background color to be used for the main view.  

 
Figure 1.5-8 Background Color Selection Dialog 

The user can click on any of the Basic Colors buttons presented to select the color to be used for 
the background.  To initiate the change, the user exits the dialog (with the ‘X’).  A prompt is 
displayed (Figure 1.5-9) reminding the user that the application must be restarted in order for the 
background change to be completed. 

 
Figure 1.5-9 Background Color Selection Warning 
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1.5.4 Units 

 
Figure 1.5-10 Units Menu (Remote Mode) 

The Units Menu allows the user to modify the displayed units of measure for all weather data. A 
check mark next to a unit indicates the current selected display units for that sensor type. Note 
that the Units menu is only accessible in Remote mode. 

1.5.4.1 Wind Speed – Miles Per Hour 
Toolbar: None 
Sets the units of measure for all wind speed indications to miles per hour. 

1.5.4.2 Wind Speed – Meters Per Second 
Toolbar: None 
Sets the units of measure for all wind speed indications to meters per second. 

1.5.4.3 Wind Speed – Knots 
Toolbar: None 
Sets the units of measure for all wind speed indications to knots. 

1.5.4.4 Temperature – Fahrenheit 
Toolbar: None 
Sets the units of measure for the air temperature indication to degrees Fahrenheit. 

1.5.4.5 Temperature – Centigrade 
Toolbar: None 
Sets the units of measure for the air temperature indication to degrees centigrade. 

1.5.4.6 Humidity – Relative Humidity 
Toolbar: None 
Sets the humidity indication to show relative humidity in percent. 
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1.5.4.7 Humidity – Dewpoint 
Toolbar: None 
Sets the humidity indication to show the dewpoint in degrees Fahrenheit or centigrade depending 
on the temperature units selected. 

1.5.4.8 Pressure – Inches Mercury 
Toolbar: None 
Sets the units of measure for the pressure indication to inches of mercury. 

1.5.4.9 Pressure – Millibars 
Toolbar: None 
Sets the units of measure for the pressure indication to millibars. 

1.5.4.10 Precipitation – Inches 
Toolbar: None 
Sets the units of measure for the precipitation indication to inches. 

1.5.4.11 Precipitation – Millimeters 
Toolbar: None 
Sets the units of measure for the precipitation indication to millimeters. 

1.5.5 Help 

1.5.5.1 HazView Help… 
Tapping on the HazView application title provides access to the standard application help 
facilities as shown in Figure 1.5-11. 

 
Figure 1.5-11 HazView Help 
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1.5.5.2 About HazView … 
Toolbar:  
Displays a dialog box (shown in Figure 1.5-12) containing information about the HazView 
application such as the current version number. 

 
Figure 1.5-12 About HazView Dialog 
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